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PROFESSIONAL DIGITAL POWER AMPLIFIERS

Notice d’utilisation
Manual de intrucciones  

A lire avant toute première utilisation
Lea atentamente antes de utilizar el producto por primera vez
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1 INTRODUCTION

Nous vous remercions d’avoir choisi un amplificateur BHM et vous souhaitons de l’utiliser avec beaucoup de plaisir.    

Cette notice a pour objectif de vous aider à mieux connaître les multiples facettes de l’appareil et à vous éviter toute
mauvaise manipulation, nous vous conseillons de suivre scrupuleusement les indications ci-dessous.
La série AMP est dotée d’une excellente qualité de fabrication, elle est munie de protections contre les surchauffes, les
courts-circuits et la visualisation de l’écrêtage. Un choix important de connexions tant en entrée qu’en sortie est proposé.
Enfin la série AMP peut fonctionner en 4 ou 8 Ω, le refroidissement se fait par un ventilateur.
Les amplificateurs AMP-1000DSP et AMP-2000DSP sont idéaux pour des utilisations très variées : Prestations de
service, Evénementiel, Salles de spectacle, Concerts, Salle polyvalente, Clubs, Discothèques ...

2 FACE AVANT 

(1) – Bouton ON / OFF :
Il permet la mise sous tension et l’arrêt de l’amplificateur. La mise sous tension est accompagnée d’une

temporisation avant l’alimentation totale de l’amplificateur. 

(2;3) – Volume :
Le volume des canaux CH.A  et CH.B peut être modifié afin de régler le niveau du signal.

(4) – LEDS SIGNAL :
La LED SIGNAL verte indique si un signal est présent à l'entrée du canal correspondant.

LEDS CLIP :
Lorsque la LED CLIP rouge s’allume, elle indique que le niveau de clip (écrêtage) est atteint sur le circuit concerné

CH.A ou CH.B. Si la LED reste en permanence allumée (seuil de saturation), il est impératif de baisser le volume du
canal correspondant.

LEDS PROTECT :
L’amplificateur est protégé contre la surchauffe et les courts-circuits en sortie vers les haut-parleurs. Si la LED

PROTECT jaune est allumée, cela indique que l’amplificateur est en mode de protection.

(5) – RS485 In :
Port d'entrée pour les signaux RS-485 en provenance du PC ou d'un autre amplificateur.

(6) – RS485 Out :
Port de sortie pour les signaux RS-485 en direction d'un AMP-1000DSP/AMP-2000DSP supplémentaire, ce port

permet de “linker” plusieurs amplis entre eux en les pilotant ainsi à partir du même ordinateur. Vous ne pouvez piloter
qu'un seul amplificateur à la fois.



(7) – Touche Menu :
Cette touche vous permet de modifier les paramètres de l'amplificateur sans utiliser un ordinateur.

(8) – Touche Enter :
Cette touche vous permet de modifier les paramètres de l'amplificateur sans utiliser un ordinateur et d'enregistrer

les modifications.

3 FACE ARRIERE

(9) – Connecteurs XLR (Inputs) :
Utilisez des câbles XLR mâles pour connecter les signaux d’entrées sur CH.A et CH.B (entrées symétriques).

(10) – Connecteurs SPEAKON® (Outputs) :
Sorties haut-parleurs.

(11) – Ventilateurs :
Veillez à ce que les ouïes d'aération soient toujours dégagées, afin que la ventilation soit toujours optimale.

(12) – Prise secteur :
La prise secteur doit être reliée à une prise d’alimentation 230V ~ / 50 Hz en utilisant le cordon secteur fourni avec

l’appareil.

(13) – Fusible :
Si vous devez changer le fusible, il est impératif de le remplacer par un fusible de mêmes caractéristiques que

celui d’origine.

4 LES SYSTEMES DE PROTECTIONS

Tous les amplificateurs de la série AMP sont équipés de protections de type industriel.
Elles permettent de protéger de manière très efficace les circuits et composants électroniques de l’appareil et les
systèmes de son branchés sur l’amplificateur.

- Protection thermique : 
Si une surchauffe anormale se produit, la LED PROTECT jaune (4) s’allume, le relais de protection coupe les sorties
haut-parleurs jusqu’au retour d’une température adéquate et le fonctionnement normal de l’amplificateur reprendra.

- Court-circuit : 
Si un court-circuit apparaît sur l’une des deux sorties (haut-parleurs défectueux, câbles haut-parleurs mal isolés…), un
court-circuit peut être dû aussi à une impédance trop faible, La LED PROTECT jaune (4) s’allume, le relais de protection
coupe les sorties haut-parleurs jusqu'à détection et réparation du court-circuit.

- Sous-tension et surtension :
En cas de sous ou surtension, l'amplificateur se mettra en protection et la LED PROTECT jaune (4) s'allumera.
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5 UTILISATION - INSTALLATION

ATTENTION : 
Avant toute utilisation, veillez à ce que votre amplificateur de la série AMP ne soit pas trop puissant par rapport aux enceintes
que vous allez y brancher afin de ne pas les détériorer. Si vous effectuez un montage de haut-parleurs, vérifiez toujours
l’impédance du système de manière à ce qu’il soit en adéquation avec l’impédance la plus basse 4 Ω. Utilisez du câble de
bonne section et de qualité. A chaque nouveau branchement, vérifiez que le câble ne soit pas endommagé. Vérifiez que les
fiches XLR, Speakon® soient bien câblées.

5.1 Installation en rack :

L’amplificateur est conçu pour une installation en rack (482 mm/19") mais peut être également posé directement sur une
étagère d'armoire technique. Dans tous les cas, l’air doit pouvoir passer sans encombre via les ouïes d’aération pour
assurer un refroidissement suffisant.
Pour un montage en rack 19", une unité est nécessaire (1 U = 44,5 mm). Pour assurer une ventilation suffisante de
l’appareil, veillez à laisser assez de place au-dessus et en-dessous de l’amplificateur. 
Afin que le rack ne se renverse pas, vous devez placer l’amplificateur dans la partie inférieure du rack. Pour une fixation
solide, la plaque avant seule n’est pas suffisante, l’amplificateur doit en plus, être maintenu par des rails latéraux ou une
plaque inférieure.

5.2 Utilisation :

Après avoir correctement connecté votre système, mettez-le en route, vous pourrez à l'aide des touches «MENU» et
«ENTER» modifier certains paramètres via les indications de l'écran LCD.

Appuyez sur «MENU» pour faire défiler les paramètres accessibles :

5.2.1 Load program (chargement programme)

Depuis l'affichage principal, appuyez 1 fois sur «Menu», vous pourrez configurer le 
chargement de programme de votre amplificateur. Appuyez sur la la touche «ENTER».

Le programme 21 est le programme par défaut, les programmes 1 à 20 sont à la disposition de l'utilisateur, il 
faut tout d'abord les éditer grâce au logiciel fourni via un ordinateur. La touche «ENTER» vous permet de passer 
d'un programme P vers un programme P+1 et la touche «MENU» d'un programme P vers un programme P-1.
Maintenez la touche «ENTER» appuyée jusqu'à ce que le programme soit chargé.

5.2.2 Setup ID

Depuis l'affichage principal, appuyez 2 fois sur «MENU», vous pourrez configurer l'ID (identification) de votre 
amplificateur. Appuyez sur la touche «ENTER».

L'ID par défaut de l'amplificateur est l'ID n°1, pour augmenter le numéro d'ID, appuyez
sur la touche «ENTER», pour diminuer le numéro d'ID, appuyez sur la touche «MENU».
Les numéros d'ID possibles vont de 1 à 255, maintenez appuyé «ENTER» jusqu'à ce 
que l'ID choisie soit sauvegardée.
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5.2.3 Gain link (chaînage Gain)

Depuis l'affichage principal, appuyez 3 fois sur «MENU», vous pourrez configurer le
«GAIN LINK» de votre amplificateur. Appuyez sur la touche «ENTER».

Le «Gain link» est en position OFF par défaut, en appuyant sur la touche «ENTER» 
vous activerez le «Gain link» qui sera affiché en position ON. Une fois le «Gain link»
activé, lorsque vous modifierez le gain d'un canal, l'autre canal subira la même modification.
Maintenez appuyé «ENTER» jusqu'à ce que le nouveau paramètre soit sauvegardé.

5.2.4 Noise gate (effet Noise Gate)

Depuis l'affichage principal, appuyez 4 fois sur «MENU», vous pourrez configurer le
«Noise gate» de votre amplificateur. Appuyez sur la touche «ENTER».

Le «Noise gate» est en position OFF par défaut, en appuyant sur la touche «ENTER», 
vous activerez le «Noise gate» qui sera affiché en position ON.
Maintenez appuyé «ENTER» jusqu'à ce que le nouveau paramètre soit sauvegardé.

5.2.5 Volume mute protect (coupure son)

Depuis l'affichage principal, appuyez 5 fois sur «MENU», vous pourrez configurer le
«Volume mute protect» de votre amplificateur. Appuyez sur la touche «ENTER».

L'«Auto mute» est en position OFF par défaut, en appuyant sur la touche «ENTER», 
vous activerez cette protection qui sera affichée en position ON.
Maintenez appuyé «ENTER» jusqu'à ce que le nouveau paramètre soit sauvegardé.

5.2.6 Display temperature (affichage de la température)

Depuis l'affichage principal, appuyez 6 fois sur «MENU», vous pourrez afficher la 
température des 2 canaux de votre amplificateur. Appuyez sur la touche «ENTER».
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La température des canaux A et B est affichée. Appuyez sur «ENTER» pour revenir
à l'affichage principal. Si la température atteint plus de 89°C, le système se met en protection 
thermique, la LED «PROTECT» s'allume et l'amplificateur affiche «TEMPERATURE PROTECT».

5.3 Pilotage de l’amplificateur via un ordinateur :

Vous pouvez piloter les amplificateurs AMP-1000DSP et AMP-2000DSP grâce à un ordinateur à l'aide du convertisseur
USB, du câble Ethernet et du logiciel de commande (livrés avec l'appareil).

6 INSTALLATION LOGICIELLE ET DRIVER USB

6.1 Installation du driver USB :

Insérez votre CD dans le lecteur de votre ordinateur.
Lancez le driver PL2303 en double-cliquant sur l'icône :

Suivez les indications à l'écran :

Une fois le driver correctement installé, cliquez sur «Finish».
Vous pouvez désormais brancher l'adaptateur USB fourni, il sera reconnu sur votre ordinateur et un port com sera créé,
faites un clique droit sur «poste de travail», puis  «propriétés», «gestionnaire de périphériques» et enfin 
“Ports (COM et LPT).

Dans notre cas, le port Prolific USB-to-Serial Comm Port a été créé sur le port «COM6», notez ce port, il vous permettra
de vous connecter à votre amplificateur en modifiant les paramètres dans la section «COM Setup» du logiciel. 

6.2 Installation du logiciel de commande :

Installez le logiciel «Amp10002000DSP» en suivant la même procédure.
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7 UTILISATION DU LOGICIEL DE COMMANDE
(Logiciel disponible uniquement en Anglais) 

7.1 Description des sous-menus :

Menu «File»
Open Permet de charger un fichier présent sur le PC
Save Permet de sauvegarder un fichier sur le PC
Memory Permet d'accéder à la mémoire de l'amplificateur et de modifier les programmes
Exit Permet de quitter le logiciel afin de retourner sur Windows*

Menu «Mode»
Stereo Mode stéréo, les entrées et sorties des canaux A et B sont indépendantes
Mono Mode mono, les signaux de sorties A et B sont identiques

Menu «Test»
Sine wave Génère une sinusoïde afin de tester le système audio, fréquences testées : 20 Hz – 20 kHz
Noise test Génère un bruit blanc pour tester l'équipement audio

Menu «Tools»
COM Setup Sélection du port sériel de communication
Search Ce menu permet de rechercher les différents amplificateurs branchés au système

sur les plages 1 à 255
Connect Etablit une connexion avec l'amplificateur
Disconnect Interrompt la connexion entre l'amplificateur et le PC

Menu «Help»
Content Index de l'aide
About Version du logiciel

7.2 Modification des paramètres :

Gain
Modifie le gain du canal correspondant. Plage de variation : -60 dB à +6 dB
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PEQ
Vous pouvez via ce menu appliquer une égalisation paramétrique sur 3 fréquences, le gain et le paramètre Q de ces

fréquences sont ajustables, la case «FLAT» permet, une fois cochée, de couper le réglage de la fréquence sélectionnée
à 0 dB

Réglage de fréquence : 19,7 Hz à 20,2 kHz
Réglage du paramètre Q : 0,4 à 128
Réglage du gain : -12 dB à +12 dB

Xover
Vous pouvez filtrer le signal afin de ne laisser passer qu'une certaine gamme de fréquence, pour cela vous devez

définir une fréquence de coupure sur un filtre passe bas et sur un filtre passe haut. Note : La fréquence de coupure du
filtre passe-bas ne peut pas être inférieure à la fréquence de coupure du filtre passe-haut.

Réglage de la pente des filtres : Vous pouvez régler la pente des filtre, en choisissant un gabarit 
dans la liste

Réglage du filtre passe-haut : Fréquence de coupure comprise entre 10 Hz et 16 kHz
Réglage du filtre passe-bas : Fréquence de coupure comprise entre 35,1 Hz et 20 kHz

Delay
Ce paramètre ajoute un «Delay» au signal, la valeur est exprimée en temps ou en distance.
Delay max. en temps : 7 ms
Delay max. en distance (mètres) : 2,40 m
Delay max. en distance (pieds) : 7,88 ft

Phase
En cochant la case «180», vous inverserez la phase du signal.

Limiter
Grâce au «Limiter», vous pourrez limiter l'intensité du signal, notamment pour protéger le système, grâce à 4

paramètres.
Limit : -61 dB à +3 dB
Hold Time : 0 ms à 100 ms
Attack Time CST : 10 dB/sec à 1000 dB/sec
Decay Time : 10 dB/sec à 1000 dB/sec

8 CONNEXION DE L'AMPLIFICATEUR ET AGENCEMENT DE LA MEMOIRE

8.1 Connexion de l'amplificateur :

Après avoir installé le logiciel fourni, connectez le convertisseur USB à l'ordinateur, connectez le câble fourni entre la
prise RS-485 IN de l'amplificateur et le convertisseur USB, démarrez le logiciel. Cliquez sur “Tools/COM Setup”.

L'application utilise le port COM1 par défaut, si vous souhaitez modifier le port COM utilisé, cliquez sur la flèche et
sélectionnez le port souhaité parmi les ports de communication sérielle affichés.
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En cliquant sur “Search” vous pourrez trouver les amplificateurs avec les «Address» de 1 à 255, les «SubAddress»
(Slave ID) ne seront pas affichées.
Cliquez sur “Connect” et sélectionnez une adresse entre 1 et 255 (Add).

N.B : Si vous paramétrez plusieurs amplificateurs sur la même adresse, vous devrez sélectionner une sous-adresse (Sub Add)
comprise entre 1 et 65536 afin de pouvoir vous connecter, c'est une valeur usine qui ne peut être modifiée ; chaque équipement
possède sa propre sous-adresse, qui s'affiche au démarrage. Cochez  la case «Sub Add» et entrez la valeur usine de
l'amplificateur.

Par défaut la case «MUTE» est cochée ; à la connexion, l'amplificateur sera en standby; en décochant la case, le gain
de l'amplificateur ne sera pas modifié.

Cliquez sur «Connect» pour vous connecter, sur «Disconnect» pour vous déconnecter.

8.2 Agencement des programmes :

L'amplificateur possède 20 plages mémoires modifiables par l'utilisateur, la plage P21 est la plage «usine», elle ne peut
être modifiée.
En cliquant sur “File/Memory”, vous pourrez sauvegarder, charger ou remettre à zéro des programmes.

Refresh 
Le logiciel analyse les programmes présents dans la mémoire de l'amplificateur

Upload
En sélectionnant un programme et en cliquant sur “Upload”, tous les paramètres correspondants seront retransmis

dans le logiciel

File Down
Permet de charger un programme sauvegardé sur le PC

Setup Down
Sauvegarde les paramètres modifiés sur un programme dans votre amplificateur

Delete
Efface le programme sélectionné

Delete All
Efface tous les programmes

Save
Sauvegarde un programme sur le PC
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9 CARACTERISTIQUES TECHNIQUES AMP - 1000  &  AMP - 2000DSP

AMP - 1000DSP AMP - 2000DSP
Puissance rms stéréo 4 Ω 2 x 500 Wrms 2 x 1000 Wrms
Puissance rms stéréo 8 Ω 2 x 300 Wrms 2 x 600 Wrms
Sensibilité d’entrée 4 Ω 0,775 V 0,775 V
Impédance d’entrée 22 kΩ 22 kΩ
Bande passante 10 – 20 000 Hz, - 0,5 dB 10 – 20 000 Hz, - 0,5 dB
Rapport signal / bruit 98 dB 100dB
Séparation des canaux > 75 dB, 1 kHz > 75 dB, 1 kHz
Taux de distorsion 0,01% à 1 kHz 300 W sous 8 Ω 0,01% à 1 kHz 600 W sous 8 Ω
Alimentation 230 V ~ / 50 Hz 230 V ~ / 50 Hz
Consommation 1250 VA max. 2500 VA max.
Effets et réglages Noise Gate, Gain, EQ paramétrique, Filtres crossover, 

Delay, Inverseur de phase et Limiteur
Température de fonctionnement 0 – 50°C 0 – 50°C
Dimensions L x H x P 482 x 320 x 45 mm, 1 U 482 x 320 x 45 mm, 1 U
Poids 6 kg 8 kg
Systèmes d'exploitation Windows XP, Windows Vista Windows XP, Windows Vista

*Windows est une marque déposée de la société Microsoft Corporation aux Etats-Unis et dans les autres pays

N.B : Le logiciel et le pilote du convertisseur USB sont aussi disponibles sur le site www.bhm-sound.fr

L’appareil répond à toutes les directives nécessaires de l’Union européenne et porte donc le symbole CE.

ATTENTION :
L'appareil est alimenté par une tension dangereuse. Ne touchez jamais l'intérieur de l'appareil et ne faites rien tomber dans 
les ouïes de ventilation car, en cas de mauvaise manipulation, vous pouvez subir une décharge électrique. 
Pendant le fonctionnement, une tension dangereuse est présente aux bornes haut-parleurs. Les branchements ne doivent être 
effectués ou modifiés que lorsque l'appareil est éteint.

Respectez scrupuleusement les points suivants :
• L’appareil n'est conçu que pour une utilisation en intérieur. Protégez-le des éclaboussures, de tout type de projections 

d'eau, d’une humidité d'air élevée et de la chaleur (température ambiante admissible 0-50 °C).
• En aucun cas, vous ne devez pas poser d'objet contenant du liquide ou un verre sur l'appareil.
• La chaleur dégagée par l'appareil doit être évacuée par une circulation d'air correcte. N'obstruez pas les ouïes de 

ventilation du boîtier.
• Ne faites pas fonctionner l’appareil ou débranchez-le immédiatement lorsque :

1. des dommages apparaissent sur l’appareil ou sur le cordon secteur.
2. après une chute ou un cas similaire, vous avez un doute sur l’état de l’appareil.
3. des dysfonctionnements apparaissent.

• Faites toujours appel à un technicien spécialisé pour effectuer les réparations.
• Ne manipulez pas l’appareil ou le cordon secteur de celui-ci si vous avez les mains humides.
• Ne le débranchez jamais en tirant directement sur le cordon secteur.
• Pour le nettoyer, utilisez un chiffon doux, en aucun cas, de produits chimiques ou d’eau.
• Ne réparez ou court-circuitez jamais un fusible endommagé mais remplacez le par un fusible de même  

type et caractéristiques.
• Nous déclinons toute responsabilité en cas de dommages matériels ou corporels résultants si l'appareil est  

utilisé dans un but autre que celui pour lequel il a été conçu, s'il n'est pas correctement branché, utilisé ou  
n'est pas réparé par une personne habilitée, en outre, la garantie deviendrait caduque.

• Lorsque l'appareil est définitivement retiré du service, vous devez le déposer dans une usine de recyclage de 
proximité pour contribuer à son élimination non polluante.

Afin de vous garantir une qualité optimale sur la fabrication de ces produits, la Société DUNE SAS se réserve le droit de modifier sans préavis les caractéristiques
techniques et configurations générales de ses appareils, dans ce cas les caractéristiques et illustrations de ce manuel peuvent être différentes. D’après les
données du constructeur. Tout droit de modification réservé. Notice d'utilisation protégée par le copyright de DUNE SAS. Toute reproduction même partielle à des
fins commerciales est interdite.
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1 INTRODUCIÓN 

Le agradecemos que haya elegido el amplificador BHM de la serie AMP,  esperamos que el producto sea de su agrado

Este manual de instrucciones tiene como objetivo ayudarle a entender las diferentes características del aparato y evitar
que se utilice inadecuadamente, le aconsejamos que haga caso de las explicaciones expuestas a continuación.
La Serie AMP dispone de una excelente calidad de fabricación, de protecciones en contra de las sobrecargas, los
cortocircuitos y de visualización del pico. Le ofrecemos  una importante selección de  entradas y salidas. Por fin la serie
AMP puede funcionar en 4 u 8 Ω, el enfriamiento se hace mediante ventilador.
Los amplificadores AMP-1000DSP y AMP-2000DSP son ideales para utilizaciones muy variadas: Prestaciones de
servicio, Eventos, Salas de espectáculos, Conciertos, Salas de fiestas, Clubs, Discotecas...

2 PARTE DELANTERA  

(1) – BOTON ON / OFF:
Permite conectar y desconectar el amplificador. La conexión va acompañada de una temporización antes de la

alimentación total del amplificador. 

(2; 3) – VOLUMEN:
El volumen de los canales CH.A  y CH.B se puede modificar para regular el nivel de señal.

(4) – LEDS SIGNAL:
El LED SIGNAL verde indica si una señal está presente en la entrada del canal correspondiente.

LEDS CLIP:
Cuando el LED CLIP rojo se enciende, indica que el nivel de clip se ha alcanzado en el circuito en cuestión CH. A

o CH .B. Si el LED queda permanentemente encendido debe bajar el volumen del canal correspondiente.

LEDS PROTECT:
El amplificador está protegido contra sobrecalentamientos y cortocircuitos en salida hacia los altavoces. Si el LED

PROTECT amarillo está conectado, indica que el amplificador está en modo de protección.

(5) – RS485 In:
Puerto de entrada para las señales RS-485 que provienen del PC o de otro amplificador.

(6) – RS485 Out:
Puerto de salida para las señales RS-485 hacia un AMP-1000DSP/AMP-2000DSP suplementario, este puerto

permite hacer un “link” entre varios amplificadores controlándolos desde un mismo ordenador. Sólo puede controlar un
amplificador a la vez.
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(7) – Botón menú:
Este botón permite modificar los parámetros del amplificador sin utilizar un ordenador.

(8) – Botón Enter:
Este botón permite modificar los parámetros del amplificador sin utilizar un ordenador y grabar las modificaciones.

3 PARTE TRASERA 

(9) – CONECTORES XLR (Inputs):
Utilice cables XLR para conectar las señales de entrada en CH.A y CH.B (entradas simétricas).

(10) – CONECTORES SPEAKON® (Outputs):
Salidas de altavoz.

(11) – VENTILADORES:
Verifique que las rejillas de ventilación estén despejadas para que la ventilación sea óptima.

(12) – TOMA DE CORRIENTE:
Conecte la toma de corriente a un enchufe 230V ~ / 50 Hz utilizando el cable entregado con el aparato.

(13) – FUSIBLE:
Si necesita cambiar el fusible, es imprescindible cambiarlo por un fusible de mismas características que el de origen. 

4 LOS SISTEMAS DE PROTECCIÓN:

Todos los amplificadores de la serie AMP disponen de numerosas protecciones de fábrica. 
Permiten proteger de manera muy eficaz los circuitos y los componentes electrónicos del aparato y los sistemas de
sonidos conectados al amplificador.

- Protección térmica: 
Si se produce un sobrecalentamiento anormal, EL LED PROTECT amarillo (4) se enciende, el relé de protección corta
las salidas de altavoces hasta que la temperatura se normalice.

- Cortocircuitos: 
Si un cortocircuito aparece en una de las dos salidas (altavoces defectuosos, cables altavoces más aislados), también
puede ser debido a una impedancia demasiada baja, el LED PROTECT amarillo (4) se enciende, el relé de protección
corta las salidas de los altavoces hasta la reparación del corto circuito.

- Baja tensión y sobretensión:
En caso de baja tensión o de sobretensión, el amplificador se pondrá en protección y el LED PROTECT amarillo (4) se
encenderá.
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5 UTILIZACIÓN – INSTALACIÓN:

ATENCIÓN: 
Antes de la primera utilización, verifique que el amplificador de la serie  AMP no sea demasiado potente para los altavoces 
que conectará para no dañarlos. Si efectúa un montaje de altavoces, verifique siempre la impedancia del sistema de manera
que esté adecuada con la impedancia  más baja de 4 Ω. Utilice cable de buena sección y de calidad. 
Cada vez que conecte el amplificador, verifique que el cable no esté dañado. Verifique que las tomas XLR, Speakon® estén
bien cableadas.

5.1 INSTALACIÓN EN RACK: 

El amplificador está fabricado para una instalación en rack (482 mm/19") pero también se puede instalar directamente
sobre una mesa. En los dos casos el aire debe circular sin ningún problema a través de las rejillas de ventilación para
que el enfriamiento sea suficiente.
Para un montaje en rack 19", necesitará una unidad de rack (1 U = 44,5 mm). Para que la ventilación del aparato sea la
adecuada, deje suficiente espacio encima y debajo del amplificador. Para que el rack no caiga, coloque el amplificador
en la parte inferior del rack. Para una buena fijación, la placa delantera no es suficiente, mantenga el amplificador con
raíles laterales o con una placa inferior.

5.2 UTILIZACIÓN:

Después de conectar correctamente el sistema, conecte el amplificador, mediante los botones «MENU» y «ENTER»
puede modificar algunos parámetros siguiendo las indicaciones de la pantalla LCD.

Pulse en «MENU» para hacer desfilar los parámetros accesibles:

5.2.1 Load program

Desde la pantalla principal, pulse una vez en «MENU», puede configurar la carga de programa  del amplificador. 
Pulse en el botón «ENTER».

El programa 21 es el programa por defecto, los programas 1 a 20 están a disposición del usuario, antes de todo 
hay que editarlos mediante el software de un ordenador. El botón  «ENTER» permite pasar de un programa  P 
hacia otro programa P+1 y el botón «MENU» de un programa P hacia un  programa P-1.
Mantenga el botón  «ENTER» pulsado hasta que el programa se cargue.

5.2.2 Setup ID

Desde la pantalla principal, pulse 2 veces en  «MENU», podrá configurar el ID (identificación) del amplificador. 
Pulse el botón «ENTER».

El ID por defecto del amplificador es ID n°1, para aumentar el número de ID pulse el botón «ENTER», para 
disminuir el número de ID, pulse el botón «MENU».
Los números de ID posibles son 1 a 255, mantenga pulsado el botón «ENTER» hasta que guarde el  ID. 
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5.2.3 Gain link

Desde la pantalla principal, pulse 3 veces en «MENU» para configurar el «Gain link» del amplificador. Pulse el 
botón «ENTER».

El «Gain link» está en OFF por defecto si pulsa el botón «ENTER» activará el «Gain link». cuando esté el  
«Gain link» activado y modifique el Gain de un canal, el otro canal afectara la misma modificación.
Mantenga pulsado el botón «ENTER» hasta que el nuevo parámetro este guardado.

5.2.4 Noise gate

Desde la pantalla principal, pulse 4 veces en el botón «MENU», para configurar el «Noise gate» del 
amplificador. Pulse la tecla  «ENTER».

El  «Noise gate» está en Off por defecto, si pulsa el botón «ENTER» activará el «Noise gate».
Pulse el botón  «ENTER» hasta que el nuevo parámetro este guardado.

5.2.5 Volum mute protect

Desde la pantalla principal, pulse 5 veces en «MENU», podrá configurar el «Volume mute protect» del 
amplificador. Pulse el botón «ENTER».

El «Auto mute» está en posición OFF por defecto, si pulsa el botón «ENTER», activará esta protección.
Pulse el botón «ENTER» hasta que el nuevo parámetro esté guardado.

5.2.6 Display temperature

Desde la pantalla principal, pulse 6 veces en el botón «MENU», aparecerá la temperatura de los 2 canales del 
amplificador. Pulse el botón «ENTER».
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La temperatura de los canales A y B aparece. Pulse en  «ENTER» para volver a la pantalla principal. Si la 
temperatura alcanza mas de 89°C el sistema se pone en protección térmica, el LED «PROTECT» se enciende 
y en el Display aparece «TEMPERATURE PROTECT».

5.3 Control del amplificador mediante un ordenador:

Puedes controlar los amplificadores AMP-1000DSP y AMP-2000DSP mediante un ordenador con un  convertidor USB.
Cable Ethernet y software de control entregados con el aparato.

6 INSTALACIÓN DEL SOFTWARE Y DRIVER CONVERTIDOR USB

6.1 Instalación del driver USB:

Insertar el CD en el lector del ordenador. 
Instalar el driver PL2303 haciendo doble click en el icono :

Seguir las instrucciones de la pantalla :

Una vez se ha instalado el driver de manera correcta hacer click en « Finish ».
Seguidamente puede conectar el adaptador USB entregado, que será reconocido por su ordenador y se creará un
nuevo puerto COM, ir a “Mi PC” y con el botón derecho del ratón ir a “Propiedades”, “Hardware”, “Administrador de
dispositivos” y “Puertos (COM & LPT)”

En nuestro caso, el puerto Prolific USB-to-Serial Comm Port se ha creado en el puerto « COM6 », anotar este puerto
que le permitirá conectarse a su recinto modificando los parámetros en la sección « COM Setup » del software.

6.2 Instalación del software:

Instalar el software «Amp10002000DSP» siguiendo el mismo procedimiento.
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7 UTILIZACIÓN DEL SOFTWARE
(Software disponible únicamente en Inglés) 

7.1 Descripción de los submenús:

Menú «File»
Open Permite abrir un fichero presente en el PC
Save Para guardar un fichero en el PC
Memory Permite acceder a la memoria del amplificador y de modificar los programas 
Exit Sale del software para volver al Windows*.

Menú «Mode»
Stereo Modo estéreo, las entradas y salidas de los canales A y  B son independientes
Mono Modo mono, las señales de salidas de salidas A y B son idénticos

Menú «Test»
Sine wave Genera una sinusoide para probar el sistema de audio, frecuencias probadas: 20 Hz – 20 kHz
Noise test Genera un ruido para probar el equipo audio

Menú «Tools»
COM Setup Selección del puerto de comunicación
Search Este menú permite buscar los diferentes amplificadores conectados al sistema en la zona 1 a 255
Connect Establece una conexión con el amplificador.
Disconnect Interrumpe la conexión entre el amplificador y el PC.

Menú «Help»
Content Índice 
About Versión software 

7.2 Modificación de los parámetros:

Gain
Modifica la ganancia del canal correspondiente. Zona de variación: -60 dB a +6 dB
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PEQ
Mediante este menú puede aplicar una ecuación paramétrica de 3 frecuencias, el Gain y el parámetro Q de estas

frecuencias son ajustables, la casilla «FLAT» permite, una vez seleccionada, cortar el reglaje de la frecuencia
seleccionada a 0 dB

Reglaje de frecuencia: 19,7 Hz a 20,2 kHz
Reglaje del parámetro Q: 0,4 a 128
Reglaje del Gain: -12 dB a +12 dB

Xover
Puede filtrar la señal para dejar pasar una cierta gama de frecuencias, defina una frecuencia de corte sobre un filtro

pasa bajo y sobre un filtro pasa alto. Nota: La frecuencia de corte del filtro pasa bajo no puede ser inferior a la
frecuencia de corte del filtro pasa alto.

Reglaje de la pendiente de los filtros: Puede regular la pendiente de los filtros eligiendo un modelo en lista 
Reglaje del filtro pasa alto: Frecuencia de corte de  10 Hz a 16 kHz
Reglaje del filtro pasa bajo: Frecuencia de corte de 35,1 Hz a 20 kHz

Delay
Este parámetro añade un «retraso» a la señal, su valor se evalúa en tiempo o en distancia.
Retraso max. En tiempo: 7 ms
Retraso max. En distancia (metros): 2,40 m
Retraso max. En distancia (pies): 7,88 ft

Phase
Seleccionando la casilla «180», invierta phase de la señal.

Limiter
Mediante el «Limitador» podrá limitar la intensidad de la señal, particularmente para proteger el sistema, mediante 4

parámetros.
Límite regulable: -61 dB a +3 dB
Hold Time: 0 ms a 100 ms
Attack Time CST: 10 dB/seg. a 1000 dB/seg.
Decay Time: 10 dB/seg. a 1000 dB/seg.

8 CONEXIÓN DEL AMPLIFICADOR Y DISPOSICIÓN DE LA MEMORIA

8.1 Conexión del amplificador:

Después de instalar el software entregado, conecta el amplificador mediante el cable entregado y el convertidor USB,
arránque el software.Haga un clic en Tools/COM Setup.

La aplicación utiliza el puerto COM1 por defecto, si desea modificar el puerto  COM utilizado, haga un clic en la flecha y
seleccione el puerto entre los puertos de comunicación que aparecen.

Haciendo un clic en Search, puede encontrar los amplificadores con los «Address» de 1 a 255, los «SubAddress»
(Slave ID) no aparecen.
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Haga un clic en Connect y seleccione una dirección entre 1 y 255 (Add).

Nota : Si configura varios amplificadores en una misma dirección, seleccione una sub dirección (Sub Add) entre 1 y 65536 para
que pueda conectarse, es un valor de fábrica que no se puede modificar, cada equipo dispone su propia sub dirección que
aparece al conectar, elija la casilla  «Sub Add» y entrar el valor de fabrica del amplificador.

Al conectar el aparato, la casilla «MUTE» esta seleccionada por defecto, el amplificador se pondrá en standby; si
deseleccionar la casilla, el Gain del amplificador no se modifica.

Haga un clic en «Connect» para desconectarse en «Disconnect».

8.2 Disposición de los programas:

El amplificador dispone de 20 memorias modificables por el usuario, la P21 es la de «fabrica» y no puede modificarse.
Haciendo un clic en File/Memory puede guardar, cargar o poner a cero los programas.

Refresh 
El software analiza los programas presentes en la memoria del amplificador 

Upload
Seleccionando un programa y haciendo un clic en Upload,  todos los parámetros correspondientes se trasmiten en el

software 

File Down
Permite cargar un programa guardado en el PC

Setup Down
Guarda los parámetros modificados en un programa del amplificador.

Delete
Borra el programa seleccionado 

Delete All
Borra todos los programas 

Save
Guarda un programa en el PC
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9 CARACTERÍSTICAS TÉCNICAS AMP - 1000  &  AMP - 2000DSP

AMP - 1000DSP AMP - 2000DSP
Potencia rms estéreo 4 Ω 2 x 500 Wrms 2 x 1000 Wrms
Potencia rms estéreo 8 Ω 2 x 300 Wrms 2 x 600 Wrms
Sensibilidad de entrada 4 Ω 0,775 V 0,775 V
Impedancia de entrada 22 kΩ 22 kΩ
Banda pasante 10 – 20 000Hz, - 0,5 dB 10 – 20 000Hz, - 0,5 dB
Relación señal / ruido 98dB 100dB
Separación de los canales > 75 dB, 1 kHz > 75 dB, 1 kHz
Tasa de distorsión 0,01% en 1 kHz 300 W a 8Ω 0,01% en 1 kHz 600 W a 8Ω
Alimentación 230 V ~ / 50 Hz 230 V ~ / 50 Hz
Consumo 1250 VA max. 2500 VA max.
Efectos y reglajes Noise Gate, Gain, EQ paramétrico, Filtros crossover, Delay, 

Inversor de phase y Limitador 
Temperatura de funcionamiento 0 – 50°C 0 – 50°C
Dimensiones B x H x P 482 x 320 x 45 mm 1U 482 x 320 x 45 mm 1U
Peso 6 kg 8 kg
Sistemas operativos Windows XP, Windows Vista Windows XP, Windows Vista

*Windows es una marca registrada de la sociedad Microsoft corporación en los Estados Unidos y en otros países

Nota: El software y el piloto del convertidor USB están disponibles en el sitio www.bhm-sound.fr

Esta unidad cumple con todas las normas que requiere la UE y por lo tanto está marcada con CE.

ATENCIÓN: 
El aparato está alimentado con un voltaje peligroso (230 V~). Deje el mantenimiento en manos del personal cualificado. No 
haga nunca ninguna modificación en el aparato que no se describa en este manual de instrucciones, podría sufrir una 
descarga.

Preste atención a  los puntos siguientes: 
• Este aparato está concebido sólo para una utilización en interiores. Protegerlo de todo tipo de proyecciones de aguas, 

de salpicaduras, de la humedad elevada y del calor (rango de temperatura permisible de 0 – 50 °C).
• En ningún caso, debe depositar objetos que contienen líquidos o un vaso encima del aparato.
• El calor generado por el equipo debe salir con la circulación de aire. Por lo tanto, la rejillas de ventilación de la caja no 

deben obstruirse.
• No conectar el equipo y desconectarlo de la red inmediatamente si se produce una de estas situaciones:

1. pueden observarse daños en el equipo o en el cable de alimentación,
2. después de una caída o accidente parecido el equipo pueda estar dañado,
3. no funciona correctamente.

• El equipo en cualquier caso solo debe repararse por personal autorizado.
• Nunca quitar el cable de alimentación del zócalo tirando del cable, sujételo siempre por la toma.
• Para la limpieza del equipo usar solamente un paño seco y blando, sin productos químicos ni agua.
• Rechazamos cualquier responsabilidad en caso de daños materiales o corporales resultandos si el aparato se utiliza 

en otro fin para el cual ha sido fabricado, si no está correctamente conectado, utilizado o reparado por una persona 
habilitada; por estos mismos motivos carecería todo tipo de garantía.

• Si se retira de servicio definitivamente la unidad, llévela a una planta local de reciclaje para su eliminación no
contaminante para el medio ambiente.

Para garantizarle una calidad óptima de los productos, DUNE SAS se reserva el derecho de modificar  sin previo aviso las características técnicas y las
configuraciones generales de los aparatos, en este caso las características y los esquemas de este manual pueden ser diferentes. Según datos del fabricante. Nos
reservamos el derecho de modificación. Manual de instrucciones protegido por el copyright de DUNE SAS. Está prohibida cualquier reproducción total o parcial de
este manual.
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